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Revision History
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Introduction

	[image: image35.wmf]Benefits of
BCMA V. 3.0 
	The Bar Code Medication Administration (BCMA) V. 3.0 software includes routines, files, enhancements, maintenance fixes, and Phase Release changes for BCMA V. 2.0. The enhancements are a direct result of feedback from the BCMA Workgroup and our many end users.

BCMA V. 3.0 software is designed to improve the accuracy of the medication administration process. By automating this process, Department of Veterans Affairs Medical Centers (VAMCS) can expect enhanced patient safety and patient care.

The electronic information that BCMA V. 3.0 provides clinicians improves their ability to administer medications safely and effectively to patients on wards during their medication passes. It also helps to improve the daily communication that occurs between Nursing and Pharmacy staffs.
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	This manual provides detailed instructions for setting the Graphical User Interface (GUI) BCMA site parameters; using the BCMA Character-based User Interface (CHUI) Manager Option; checking the Drug Internal Entry Number (IEN) Code on Unit Dose medications; entering a reason for a Missing Dose Request; resetting user parameters; and using the Trouble Shoot Med Log. 

Our Target Audience

We have developed this manual for individuals within the following groups, who are responsible for managing the site parameter settings for your VAMC.

· Information Resources Management (IRM)

· Clinical Applications Coordinator (CAC) — called Applications Package Coordinator (ADPAC) at some VAMCs
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	Refer to the Web sites listed below when you want to receive more background and technical information about BCMA V. 3.0, and to download this manual and related documentation.

Background/Technical Information

From your Intranet, enter http://vista.med.va.gov/bcma in the Address field to access the BCMA Main Web page.

This Manual and Related Documentation

From your Intranet, enter http://www.va.gov/vdl in the Address field to access this manual, and those listed below, from the VistA Documentation Library (VDL).

· Installation Guide

· Technical Manual/Security Guide

· GUI User Manual

· Nursing CHUI User Manual

· Pharmacy CHUI User Manual
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Conventions Used in This Manual
	Throughout this manual, you will find a variety of elements designed to help you work more efficiently with BCMA 3.0. They include the many conventions listed below.

· Keyboard Responses: Keys provided in boldface, within the copy, help you quickly identify what to press on your keyboard to perform an action. For example, when you see enter or <Enter> in the copy, press this key on your keyboard.

· Within the GUI Steps: Use the arrow keys to Select your division name, and then press enter. 
· Within the CHUI Steps: At the “Select User to Reset:” prompt, enter the user’s name and then press <Enter>. 

· Mouse Responses: Buttons provided in boldface, within the steps, indicate what you should select on your computer screen using the mouse. For example, when you see next, yes/no, or ok in the steps, click or select the appropriate button on your computer screen. 
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	Conventions Used in This Manual (cont.)
	· User Responses: Information presented in boldface, within the steps, indicate what you should “type” (enter) onto your computer screen. For example, At the “Select OPTION NAME:” prompt, type XPD MAIN and then press <Enter>.

· Screen Captures: Provide “shaded” examples of what
you will see on your computer screen, and possible user responses.

· Notes: Provided within the steps, describe exceptions or special cases about the information presented. They reflect the experience of our Staff, Developers, and Testers.

· Tips: Located in the left margin, these helpful hints are designed to help you work more efficiently with BCMA
V. 3.0.

· Menu Options: When provided in italics, identifies a menu option. When provided in boldface, ALL CAPS, identifies the letters that you should type onto your computer screen, before pressing <Enter>. The system then goes directly to the menu option or field. (Note: The letters do not have to be entered as capital letters, even though they are provided within the steps in this format.) See the example provided below.

· At the Bar Code Medication Administration Manager menu, type T, and then press <Enter> to access the Trouble Shoot Med Log [PSB MED LOG TROUBLE SHOOTER] option.
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	Obtaining On-line Help
	On-line help is designed right into the CHUI version of BCMA V. 3.0, making it quick and easy for you to get answers to your questions. Here’s how to access help in CHUI BCMA:

· CHUI BCMA: Lets you enter up to three question marks at any prompt to receive on-line help. 

· One Question Mark: Provides a brief statement related to the prompt. 

· Two Question Marks: Displays more detailed information about the prompt, plus any hidden actions.

· Three Question Marks: Provides more detailed help, including a list of possible answers.




Setting Site Parameters for GUI BCMA
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GUI BCMA Site Parameters Application
	Use this section to sign on (log on) to the GUI BCMA Site Parameters application.

Note: The initial process of signing on to the GUI BCMA Site Parameters application is the same for each site. 

To sign on to GUI BCMA Site Parameters application

1 Double-click on the BCMA icon on your desktop. The Connect To Selection dialog box may display. This will depend on your system set-up.

Example: Connect To Selection Dialog Box
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2 Select the Server connection for your site, and then click ok. The VistA Sign-on dialog box displays. 

Example: VistA Sign-on Dialog Box
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Setting Site Parameters for GUI BCMA

	Signing on to
GUI BCMA Site [image: image45.wmf]Parameters Application (cont.) [image: image46.wmf]
	To sign on to GUI BCMA Site Parameters application (cont.)

3 In the Access Code field, type your Access Code, and then press tab.

· If the “blinking” cursor does not display in this field, click once in the field to activate it.

Keyboard Shortcut: Press tab to move among the fields and buttons on the dialog box.

4 In the Verify Code field, type your Verify Code, and then
click ok. A Warning message displays.
· If the “blinking” cursor does not display in this field, click once in the field to activate it.

Keyboard Shortcut: Press enter after typing the codes to display a Warning message. 
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	Signing on to
GUI BCMA Site Parameters Application (cont.)
	· If Your VAMC Has Multiple Divisions

The Select Division dialog box, provided below, displays if your VAMC has multiple divisions. 

To Select a Division:

1 Select a division that corresponds to your VAMC, and then click ok.

Keyboard Shortcut: Use the arrow keys to Select your division name, and then press enter.
Example: Select Division Dialog Box

[image: image3.png]4 Select Division [-1o[x]

Must Select Division To Continue Signon!

(500) ALBANY, NY

(514) BATH, NY

oK X Cancel | 7 Help





5 Continue with the sign-on process.




Setting Site Parameters for GUI BCMA

	Signing on to
GUI BCMA Site Parameters Application (cont.)
	To sign on to GUI BCMA Site Parameters application (cont.)

Example: Warning Message About Updates to Parameters Being Immediate
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6 Review the Warning message, and then click ok. The BCMA Site Parameters Opening Screen displays.

Example: BCMA Site Parameters Opening Screen
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Running the Unknown Action Status Report
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	You can use the Unknown Action Status Report [PSBO XA] option from the Bar Code Medication Administration Manager menu to print a listing of administrations that have an unknown action status. When a user is in the process of documenting an administration in Manual Medication Entry [PSB MED LOG NEW ENTRY], the administration status initially defaults to blank (null). If the order is not completed with a valid administration status, the Admin Status will be listed as unknown, and appear on the Unknown Action Status Report. 

The unknown (null) status can occur during Manual Medication Entry when the user’s network connection is broken, their terminal emulator software malfunctions, or if the user improperly exits out of the application.

Use the BCMA GUI Edit Med Log to correct the administration status of any entries found on this report.

Note: This report is only accessible to users with the PSB MANAGER security key. 
To run the Unknown Action Status Report
7 At the Bar Code Medication Administration Manager menu, type U, and then press <Enter> to access the Unknown Action Status Report [PSBO XA] option. The associated screen then displays.

Example: Unknown Action Status Report
Report Criteria Screen
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	Defining and Updating Site Parameters for Your Division
	You are now ready to update existing GUI BCMA site parameters for your VAMC.

To define and update site parameters for your division

8 Select the Open command from the File menu. The Division Selection dialog box displays.

Keyboard Shortcut: Press alt+f to display the File menu, and then press o to select the Open command.

Example: Division Selection Dialog Box
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3 Enter the number of the division that corresponds to your VAMC, and then click ok. The BCMA Site Parameters Main Screen displays, with the Facility Tab selected.

Keyboard Shortcut: Press tab to activate the ok button, and then press enter to continue with the defining and updating process. 




Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	To define and update site parameters for your division (cont.)

Example: BCMA Site Parameters Main Screen with Facility Tab Selected
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4 Review the sections that follow to acquaint yourself with each Tab and the options available to your VAMC.
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	Defining and Updating Site Parameters for Your Division (cont.)[image: image49.wmf]
	Working with the Facility Tab

The Facility Tab, on the BCMA Site Parameters Main Screen, provides the following functions:

· Facility Information (Read-Only): This area provides read-only information populated by the INSTITUTION
file (#4).

· BCMA On-Line: This option (check box) under the “BCMA Status for Division” section lets IRM personnel enable or disable all GUI BCMA options. It does not affect CHUI BCMA options.

· If the “BCMA On-Line” check box is checked, the system is on-line and all GUI BCMA options are available.

· If the “BCMA On-line” check box is not checked, all users currently logged on to GUI BCMA options will not be affected. However, when a user attempts to log on to the GUI options, the following Error message displays:

Example: Error Message When BCMA

Not Active for Your Site

[image: image50.wmf]
· If the “BCMA On-Line” check box is checked and you try to take it off-line by deselecting the check box, the following Warning message displays:

Example: Warning Message When All BCMA Users
Are Being Disabled for Your Division
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Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Parameters Tab

You can activate the Parameters Tab by placing the cursor over the Tab, and then clicking once on it. Doing so activates the site parameters for this Tab. 

This section describes the fields and check boxes available on the Parameters Tab.

Example: BCMA Site Parameters Tab
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· Output Devices Area

· Scratch HFS (Host File Server) Directory: This field lists the directory accessible to all BCMA V. 3.0 users, required at every division running BCMA. The directory includes reports that BCMA V. 3.0 generates and retrieves. 

· If the field is blank, BCMA V. 3.0 uses the Default Directory for the HFS entry in the Kernel SYSTEM PARAMETERS file.
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	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Parameters Tab (cont.)

· Output Devices Area (cont.)

· Missing Dose Request Printer: This field identifies the default division printer for Missing Dose requests.

· Mail Groups Area

· Mail Groups: This area lists the mail groups that must be created using the VistA Mail Group Edit [XM EDIT MG] option, and by setting the TYPE field to PUBLIC. BCMA
V. 3.0 includes the following mail groups listed below:
· Due List Error: This field generates an E-mail message for any medication order that BCMA cannot resolve for VDL placement, and sends it to the mail group members. An example might include no administration times entered for a Continuous order. 

· Missing Dose Notification: This field generates an E-mail message for any Missing Dose Request entered using the BCMA CHUI or GUI menu options. The E-mail is sent to all members of the mail group, specifically Pharmacy, as a “fail safe” even if the designated Missing Dose printer is not functioning.
· Unknown Actions: This field generates an E-mail message for any administration with an “Unknown” status while processing administrations to display on the VDL.
· Reports Area

· Include Comments: This check box, when selected, will automatically check the “Include Comments” check box in the Report dialog box as the default setting for the Medication History Report and the Medication Log Report. If this parameter is unchecked, the “Include Comments” check box will be unchecked, by default, in the related Report dialog box. Users can choose to change the check box setting in the Printer dialog box as needed, depending on whether they wish to have the comments for the administration included on the report.

· Med Hist Days Back: This field lets you define the number of days in the past, from the current system date, that the Medication History Report should retrieve data. The allowable entry for this parameter is 1 to 9999 days. The default is 30 days.

· A user can change the date range, for the report,
in the Report dialog box.


Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Parameters Tab (cont.)

· Bar Code Options Area

· Default Bar Code Format: This field lets you select the desired bar code format that you want to produce on the bar code label printer. The following options are available from a drop-down list box: C39, 128, and I25.

· Default Bar Code Prefix: This field lets you specify up to five alphanumeric characters of text that will print as a prefix on a bar code label printed on the bar code label printer. 

· Using Robot RX: This check box should be checked only if your site is using the Robot RX product.

· Administration Area

· Require ESig To Administer Medication: This check box requires that users enter the Access/Verify and Electronic Signature Code (ESig) before launching GUI BCMA. Otherwise, the clinician administering medications will be asked for Access/Verify codes only.

· Allow Multiple Admins for On-Call: When checked, your division allows multiple administrations for an On-Call order.

· Allowable Time Limits In Minutes Area
· Before and After Scheduled Admin Time: This parameter defines the allowable medication administration timeframe. In the example provided, the allowable timeframe is set to one hour before through one hour after the scheduled administration time. Each window may be defined up to 240 minutes.

· PRN Effectiveness Entry: This parameter defines the allowable time for the PRN Effectiveness to be assessed, after a PRN medication is given by a clinician, and before a variance is logged. If a medication administration is outside the allowable time, a variance will be logged when the effectiveness is entered. You can define this window up to 240 minutes. 
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	Defining and Updating Site Parameters for Your Division (cont.)[image: image51.wmf]
	Working with the Parameters Tab (cont.)

· Virtual Due List Default Times Area

· Start Time and Stop Time: This option lets you enter the number of hours before and after NOW that GUI BCMA will initally display orders on a patient’s VDL (i.e., patient record).

· Include Schedule Types Area 
· These check boxes let you select the default display for the CHUI Menu Option Due List [PSBO DL] and the BCMA VDL. The PRN check box controls the default display of PRN medications on the VDL. Your VAMC can choose to have the PRN Schedule Types display on the VDL by default, or to display PRN medications once the clinician selects the PRN Schedule Type check box on the VDL. All other Schedule Types will display by default and cannot be changed.

· Individual client settings are not allowed.
· Misc Options Area

· Max Client/Server Clock Variance: This field lets you specify the number of minutes allowed for a variance, between the Client clock and the Server clock time. 

· If outside the range, a Warning message displays.

· Patient Transfer Notification Timeframe In Hours: This field lets you define the number of hours, before the current system time, that a patient movement must be less than for the movement type (usually a transfer) to display on the BCMA VDL. The allowable entry for this parameter is a minimum value of 2 and a maximum value of 99. The default is 72 hours.

· Individual client settings are not allowed.
· BCMA Idle Timeout In Minutes: This field lets you define the number of minutes before BCMA becomes inactive. The default is 1 minute.
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	[image: image52.wmf]Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Parameters Tab (cont.)

· Misc Options Area (cont.)
· PRN Documentation In Hours: This field lets you define the minimum number of hours from NOW that BCMA V. 3.0 will search for PRN medication orders needing effectiveness comments. The four most recent PRN orders that need documentation display within the PRN Effectiveness mouse-over list in the “BCMA Clinical Reminders” marquee, which is located in the lower, right-hand corner of the VDL. BCMA displays PRN medications based on the current admission or the site parameter timeframe (whichever is greater). The allowable entry for this parameter is a minimum value of 1 and a maximum value of 999. The default is 72 hours.

· Individual client settings are not allowed.
· Max Date Range: This field lets you specify the maximum number of days allowed for the IV Bag Status and Medication Therapy reports. A warning message will display if the user attempts to run these reports beyond the number of days allowed by this site parameter. No default.

· Patch Display Duration: This field lets you specify the number of days after an order’s Stop Date that a “Given” patch will continue to display on the VDL and Cover Sheet. The allowed values are:  Always Display and 7‑14 days. The display date will be calculated by adding the number of days defined in the site parameter to the Stop Date of the order. If the value of the site parameter is Always Display, then the patch will continue to display on the VDL until it is marked as removed using the Due List–regardless of the order Stop Date. The default is Always Display.

· Enable CPRS Med Order Button: Selecting this button allows clinicians to use the CPRS Med Order Button in BCMA V. 3.0 to electronically order, document, review, and sign verbal- and phone-type STAT and NOW (One-Time) medication orders that they are administering to patients. 

· Clinicians can access the CPRS Med Order Button functionality only if they hold the PSB CPRS MED BUTTON security key.

· Clinicans must be able to accept and sign orders in CPRS to use the CPRS Med Order Button functionality in BCMA V. 3.0.




Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)[image: image53.wmf]
	Working with the Default Answer Lists Tab

You can activate the Default Answer Lists Tab by placing the cursor over the Tab, and then clicking once on it. Doing so activates the site parameters for the Default Answer Lists Tab. 

Example: Default Answer Lists Tab Selected
and List Names Provided
[image: image11.png]BCMA
Fie Help

Parameters [_[C1x]

ooty | P | Dok rone s [ P
| Defauit Answer Lists

List Name:

I | Savelis

Reason Medication Given PRN
Reason Medication Held
Reason Medication Refused
Injection Sites





You can use the Default Answer Lists Tab to define the Selection Lists for the following options. These lists are free-text and definable on a divisional basis.

· Reason Medication Given PRN

· Reason Medication Held

· Reason Medication Refused

· Injection Sites
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	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Default Answer Lists Tab (cont.)

You can display Default Answer Lists Names by clicking once on the down arrow on the List Name drop-down list box. To select a list, highlight a selection in the list box. Then you are ready to create each list within the text box provided. See the example provided below.

Note: The Attribute column is available only when you choose the Default Answer Lists for “Reason Medication Given PRN.”

Example: Selecting a Default Answer Lists Name
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Note: This section provides examples of suggested Default Answer Lists for the List Names shown above in the drop-down list.
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	Defining and Updating Site Parameters for Your Division (cont.)[image: image54.wmf][image: image55.wmf]
	Working with the Default Answer Lists Tab (cont.)

You can create a list by pointing inside the text box associated with a list item, and then clicking the right mouse button. You may Add, Rename, or Delete any item within the box by highlighting the option within the List Items box, and then clicking on the right mouse button to make your selection. To activate the Rename or Delete functions for one of the listings, highlight the listing, and then click on the related command in the list box. 

After you complete a list, click on the Save List button to store your list before exiting the Default Answer Lists Tab.

Note: A warning message displays if you attempt to enter more than 100 entries in a Default Answer Lists.

Example: Creating a Default Answer List for

“Reason Medication Given PRN”
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Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Default Answer Lists Tab (cont.)

This section provides suggested entries for the Default Answers Lists for GUI BCMA V. 3.0.




Example: Suggested Default Answer List for
”Reason Medication Given PRN”

	Reason #:
	Value

	1
	Agitation

	2
	Anxiety

	3
	Arrhythmia

	4
	Chest Pain

	5
	Congestion

	6
	Constipation

	7
	Cough

	8
	Cramps

	9
	Diarrhea

	10
	Discomfort

	11
	Dizziness

	12
	Dyspepsia

	13
	Dysuria

	14
	Elevated Blood Pressure

	15
	Elevated Blood Sugar

	16
	Extrapyramidal Symptoms

	17
	Fever

	18
	Gastritis

	19
	Headache

	20
	Hiccups

	21
	Indigestion

	22
	Insomnia
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	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Default Answer Lists Tab (cont.)

This section provides suggested entries for the Default Answers Lists for GUI BCMA V. 3.0.




Example: Suggested Default Answer List for

“Reason Medication Given PRN” (cont.)

	Reason #:
	Value

	23
	Irritation

	24
	Itching

	25
	Low Blood Pressure

	26
	Low Blood Sugar

	27
	Muscle Spasm

	28
	Nausea

	29
	Nervousness

	30
	Nightmares

	31
	Nocturia

	32
	Oliguria

	33
	Pain

	34
	Psychosis

	35
	Seizures

	36
	Shortness of Breath

	37
	Sore Throat

	38
	Tremors

	39
	Vertigo

	40
	Vomiting

	41
	Wheezing

	42
	Withdrawals
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	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Default Answer Lists Tab (cont.)

This section provides suggested entries for the Default Answers Lists for GUI BCMA V. 3.0.




Example: Suggested Default Answer List for

“Reason Medication Held”

	Reason #:
	Value

	1
	Agitation

	2
	Apical Pulse Out of Range

	3
	Authorized Absence

	4
	Blood Pressure Out of Range

	5
	Blood Sugar Out of Range

	6
	Constipation

	7
	Diarrhea

	8
	NPO

	9
	Obtunded

	10
	Off Ward

	11
	On Pass

	12
	Provider Ordered

	13
	Respirations Out of Range

	14
	Sleeping

	15
	Somnolent

	16
	Temperature Out of Range

	17
	HEALED


Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Default Answer Lists Tab (cont.)

This section provides suggested entries for the Default Answers Lists for GUI BCMA V. 3.0.




Example: Suggested Default Answer List for

“Reason Medication Refused”

	Reason #:
	Value

	1
	Diarrhea

	2
	Emesis

	3
	Nausea

	4
	Patient Request

	5
	Patient Spit Out


Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the Default Answer Lists Tab (cont.)

This section provides suggested entries for the Default Answers Lists for GUI BCMA V. 3.0.




Example: Suggested Default Answer List for

“Injection Sites”

	Injection Site #:
	Value

	1
	Abdomen, Left Lower Quad

	2
	Abdomen, Left Upper Quad

	3
	Abdomen, Right Lower Quad

	4
	Abdomen, Right Upper Quad

	5
	Arm, Left Upper

	6
	Arm, Right Upper

	7
	Back, Upper Left

	8
	Back, Upper Right

	9
	Buttock, Left

	10
	Buttock, Right

	11
	Deltoid, Left

	12
	Deltoid, Right

	13
	Gluteal, Left Ventral

	14
	Gluteal, Right Ventral

	15
	Gluteus Medius, Left

	16
	Gluteus Medius, Right

	17
	IV/Lock

	18
	Thigh, Left

	19
	Thigh, Right

	20
	Thigh, Mid-Anterior Left

	21
	Thigh, Mid-Anterior Right

	22
	Vastus Lateralis, Left

	23
	Vastus Lateralis, Right


Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the IV Parameters Tab

You can activate the IV Parameters Tab by placing the cursor over the Tab, and then clicking once on it. Doing so activates the site parameters for this Tab. 

The IV Parameters Tab lets you configure the business logic that BCMA V. 3.0 will use when processing an IV order that has been changed. You can configure this option using the following hierarchy: Division and Ward.

When BCMA V. 3.0 is first installed, it automatically sets up the recommended default settings for the division and all IV types. 

Note: Although the default settings are highly recommended by the BCMA Workgroup, you can still change them for your site.

Example: Site Parameters Available
When IV Parameters Tab Selected
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Setting Site Parameters for GUI BCMA

	[image: image58.wmf][image: image59.wmf]Defining and Updating Site Parameters for Your Division (cont.)
	Working with the IV Parameters Tab (cont.)

This section describes each field that is available when you select the IV Parameters Tab.

· Location Area

· Ward: This field lets you configure the IV parameter by division (ALL) or by an individual ward. “ALL” is the default setting for a division. This setting includes all wards.

· A ward provided in boldface, in the drop-down list box, indicates that an IV parameter has been set up.

· You may change the configuration on an individual ward basis by selecting a ward from the Ward drop-down list box, making selections from the Prompts section, and then clicking ok to accept the changes. 

Example: Ward Drop-Down List Box
for Location Area
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Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)[image: image60.wmf]
	Working with the IV Parameters Tab (cont.)

This section describes each field that is available when you select the IV Parameters Tab.

· IV Type Area

· Type: This field lets you configure the IV parameter by
IV Type. They include: Admixture, Chemotherapy, Hyperal, Piggyback, and Syringe. 

· An IV Type listed in boldface, in the list box, is set up for the selected ward.

Example: Type Drop-Down List Box
for IV Type Area
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Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the IV Parameters Tab (cont.)

This section describes each field that is available when you select the IV Parameters Tab.

· Prompts Area

· Includes fields from the Inpatient Medications V. 5.0
IV Order Entry screen. They include the following: Additive, Strength, Bottle, Solution, Volume, Infusion Rate, Med Route, Schedule, Admin Time, Remarks, Other Print Info, Provider, Start Date/Time, Stop Date/Time, and Provider Comments. 

· Each field offers a selection of Warning, Non-Verify, and Invalid Bag.

Example: Prompts Drop-Down List Box
for Additive Field
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Setting Site Parameters for GUI BCMA

	Defining and Updating Site Parameters for Your Division (cont.)
	Working with the IV Parameters Tab (cont.)

· Prompts Area (cont.)

· Should you determine that you need to change the Prompts default settings, you will receive an Information message notifying you that your selection is not recommended for that particular option.

Example: Information Message
When Prompts Default Settings Changed
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· If a field is set to Warning, and an order is changed, the
IV bags from the old order are carried to the new order and display on the BCMA VDL. When you scan the bar code on an IV bag, a Warning message alerts you about fields that have changed. GUI BCMA would then display the Scan IV dialog box so you can begin infusing the IV bag. 

Example: Warning Message That Fields
in Inpatient Medications V. 5.0 Changed
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· If a field is set to Non-Verify, and an order is changed, the
IV bags from the old order are carried to the new order and display on the BCMA VDL. When you scan a bar code on an IV bag, NO warning message displays. The Scan IV dialog box automatically displays so you can begin infusing the
IV bag.

· If a field is set to Invalid Bag, and an order is changed, the IV bags from the old order do not carry to the new order or display on the BCMA VDL.


Accessing the CHUI BCMA Manager Menu

[image: image61.wmf]

	Accessing the
CHUI BCMA Manager Menu
	You can use the Bar Code Medication Administration Manager menu to access information entered by clinicians via the BCMA VDL within CHUI BCMA V. 3.0. You can access this menu option from any VistA-enabled terminal within your VAMC.

Because BCMA operates in real time, scanned patient and medication information is available as soon as the “scan” is successfully completed using GUI BCMA.

To access the CHUI BCMA Manager Menu

9 At a VistA-enabled terminal, enter your Access and Verify Codes when prompted by the system. The menus available to you will then display. 

Example: Accessing the CHUI BCMA Manager Menu
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10 At the “Select BCMA NURSING MENU Option:” prompt,
type BAR, and then press <Enter> to access the Bar Code Medication Administration Manager menu. The options available to you then display.

11 At the “Select Bar Code Medication Administration Manager Option:” prompt, enter the text of the desired option, and then press <Enter>. The Main Screen for the associated option then displays.




Checking the Drug IEN Code for Unit Dose Meds

	Verifying the Drug IEN Code for a Unit Dose Medication
	You can use the Drug File Inquiry [PSB DRUG INQUIRY] option from the Bar Code Medication Administration menu to verify the Drug IEN Code for Unit Dose medications. This option is particularly useful when you need to resolve a discrepancy with an IEN Code for a medication.

To verify the drug IEN code for a Unit Dose medication

12 At the Bar Code Medication Administration Manager menu, type D to access the Drug File Inquiry [PSB DRUG INQUIRY] option. The associated screen displays.

Example: Drug File Inquiry Screen
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13 At the “Select DRUG:” prompt, type the name and dosage of the drug that you want an IEN Code, and then press <Enter>. The associated drug file information, or other IEN information, then displays. See the next page for an example.




Checking the Drug IEN Code for Unit Dose Meds

	Verifing the Drug IEN Code for a Unit Dose Medication (cont.)
	To verify the drug IEN code for a Unit Dose medication

(cont.)

Example: Results of Drug File Inquiry
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Note: The IEN Code appears on the first line, to the right of the Drug Name. Typically, this is the bar code number on the Unit Dose package prepared by the Pharmacy. Manufacturers’ National Drug Code (NDC) bar codes may appear in the SYNONYMS field within this screen. If the drug is non-formulary, the NON-FORMULARY field will be set to N/F.




Responding to Missing Dose Requests

	Creating a Follow-up Message for a Missing Dose Request
	The Missing Dose Followup [PSB MISSING DOSE FOLLOWUP] option from the Bar Code Medication Administration Manager menu lets the Pharmacy electronically respond to a Missing Dose Request submitted by a clinician from BCMA V. 3.0. The Pharmacy can enter a reason that the dose was missing, the time the dose was delivered, and the name of the individual who delivered the dose.

To create a follow-up message for a Missing Dose Request

14 At the Bar Code Medication Administration Manager menu, type MI, and then press <Enter> to access the Missing Dose Followup [PSB MISSING DOSE FOLLOWUP] option. The associated screen then displays.

Example: Missing Dose Request Selection Screen
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15 At the “Select Missing Dose Request # (<RET> to continue,
‘^’ to quit):  (1-7):” prompt, type the number opposite the Missing Dose that you want to create a follow-up message for, and then press <Enter>. The Missing Dose Request Pharmacy Follow-up Information screen, provided on the following page, then displays.




Responding to Missing Dose Requests

	Creating a Follow-up Message for a Missing Dose Request (cont.)
	To create a follow-up message for a Missing Dose Request (cont.)

Example: Missing Dose Request Entry Screen
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16 At the DOSE DELIVERED field, type Yes, and then press <Enter>.

· If a medication is no longer active or will not be delivered, type No in this field.

17 At the DELIVERY DATE/TIME field, type N (for Now) or the date and time that the dose was delivered, and then press <Enter>.




Responding to Missing Dose Requests

	Creating a Follow-up Message for a Missing Dose Request (cont.)[image: image62.wmf]
	To create a follow-up message for a Missing Dose Request (cont.)

18 At the PHARMACY REASON NEEDED field, type the number that corresponds to your selection from the Pharmacy Reasons Needed Selection Table provided below. 

19 At the COMMAND field, perform one of the following actions:

· Type S, and then press <Enter> to save the information that you entered for the Missing Dose Request selected.

· Type E, and then press <Enter>  to exit the Followup Information Screen.

· If you try to exit the screen without saving the data, the system displays the message: “Save changes before leaving form (Y/N)?” Type N (for No), or Y (for Yes), and then press <Enter>. The system confirms that the data has been saved, and returns you to the “Select Bar Code Medication Administration Manager Option:” prompt. 

· Type R, and then press <Enter> to refresh the Followup Information Screen. 




Example: Pharmacy Reasons Needed Selection Table

	Number
	Pharmacy Reasons Needed

	1
	WS/FILL ON REQUEST

	2
	FOUND IN DRAWER

	3
	PHARMACIST ERROR

	4
	EXPIRED/NO ORDER

	5
	ATC ERROR

	6
	NOT ENOUGH PRNS

	7
	TECHNICIAN ERROR

	8
	ON PRE-EXCHANGE/PICK LIST

	9
	PATIENT TRANSFERRED

	10
	NURSE ADMIN ERROR


Resetting User Parameters

	[image: image63.wmf]Resetting a
User’s Default Parameter Settings
	Once a clinician uses BCMA V. 3.0, the parameters become their default settings. For example, when they change the default settings for certain fields (i.e., Start and Stop Times, and Column Sort Selection) on the BCMA VDL, these settings are retained in their user parameters — and become the default settings each time they log on to BCMA V. 3.0. This does not apply to the Unit Dose Tab, which is the default view or to Schedule Types, which are all selected each time you open a VDL (i.e., patient record).

You can reset these user-selected parameters to site-defined parameters using the Reset User Parameters [PSB USER PARAM RESET] option in BCMAV. 3.0.

To reset a user’s default parameter settings

20 At the Bar Code Medication Administration Manager menu, type RE to access the Reset User Parameters [PSB USER PARAM RESET] option. The associated screen then displays.

Example: Reset User Parameters Sequence Screen
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21 At the “Select User to Reset:” prompt, enter the user’s name, and then press <Enter>. A prompt displays.




Resetting User Parameters

	Resetting a
User’s Default Parameter Settings (cont.)
	To reset a user’s default parameter settings (cont.)

22 At the “Are you sure you want to reset all parameters for this user? No//” prompt, perform one of the following actions:

· To accept the default answer of No, press <Enter>. The system will not reset the user’s parameters. You will be returned to the Bar Code Medication Administration Manager Menu.

· To reset the user parameters, type Y at the prompt, and then press <Enter>. The system then provides a message of “Resetting…Done” to indicate that the user parameters have been reset. See the Example on the previous page for more details.




Using the Trouble Shoot Med Log

	Identifying Scanning Problems
	You can use the Trouble Shoot Med Log [PSB MED LOG TROUBLE SHOOTER] option from the Bar Code Medication Administration Manager menu to determine the reason that a medication is not being marked on the BCMA VDL within BCMA V. 3.0 as “Given,” even though it is being scanned during a medication pass.

To identify scanning problems using the Trouble Shoot
Med Log

23 At the Bar Code Medication Administration Manager menu, type T to access the Trouble Shoot Med Log [PSB MED LOG TROUBLE SHOOTER] option. The associated screen then displays.

Example: Medication Log Trouble Shooter Screen
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24 At the “Select PATIENT:” prompt, enter the patient’s name, and then press <Enter>. CHUI BCMA provides data related to the patient name that you entered.

· For a list of standard name and date formats, type ? in the “Select PATIENT:” and Select Date To Validate:” prompts, and then press <Enter>. 

25 At the “Select Date To Validate:” prompt, enter the desired date, and then press <Enter>. CHUI BCMA searches the database for every order for the selected patient and date you entered, and then displays a list of related orders. See the Example on the next page for more details.




Using the Trouble Shoot Med Log

	Identifying Scanning Problems (cont.)
	To identify scanning problems using the Trouble Shoot
Med Log (cont.)

Example: Medication Log Trouble Shooter Screen (cont.)
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26 At the “Enter a number (###):” prompt, enter the number that corresponds to the desired order in the selection list, and then press <Enter>. The selected order will display with the prompt “Is this the correct Order? Yes//” 

· If the list is longer than one screen, you will receive the prompt “Enter RETURN to continue or ‘^’ to exit.” Press <Enter> to display the rest of the list. 




Using the Trouble Shoot Med Log

	[image: image64.wmf]Identifying Scanning Problems (cont.)
	To identify scanning problems using the Trouble Shoot
Med Log (cont.)

Example: Order Validation Screen
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27 At the “Is this the correct Order? Yes//” prompt, press <Enter> to accept the default answer of Yes, and to display information about the order that you selected. The Order Validation Screen displays.

28 At the “Enter the DATE of Administration: Today//” prompt, press <Enter> to select today’s date. Otherwise, enter another date, and then press <Enter>. A variance reason displays, related to the order that you selected. 

· If there is more than one administration time for the order, the system will list the times. 

29 At the “Select Administration Time:” prompt, type the number corresponding to the desired administration time listed, and then press <Enter>. The system lists information related to the order’s administration time.

30 Perform one of the following actions:

· Press <Enter> to return to the list of medications for the selected patient and administration date.

· Press ^ to exit the option. 




Running the Unknown Action Status Report
	[image: image65.wmf][image: image66.wmf]Creating a Listing of Unknown Actions


	You can use the Unknown Action Status Report [PSBO XA] option from the Bar Code Medication Administration Manager menu to print a listing of administrations that have an unknown action status. When a user is in the process of documenting an administration in Manual Medication Entry [PSB MED LOG NEW ENTRY], the administration status initially defaults to blank (null). If the order is not completed with a valid administration status, the Admin Status will be listed as unknown, and appear on the Unknown Action Status Report. 

The unknown (null) status can occur during Manual Medication Entry when the user’s network connection is broken, their terminal emulator software malfunctions, or if the user improperly exits out of the application.

Use the BCMA GUI Edit Med Log to correct the administration status of any entries found on this report.

Note: This report is only accessible to users with the PSB MANAGER security key. 
To run the Unknown Action Status Report
31 At the Bar Code Medication Administration Manager menu, type U, and then press <Enter> to access the Unknown Action Status Report [PSBO XA] option. The associated screen then displays.

Example: Unknown Action Status Report
Report Criteria Screen
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Running the Unknown Action Status Report
	Creating a listing of Unknown Actions (cont.)


	32 At the “Report Criteria” screen, enter the desired Start Date, Stop Date, Division, and Print to DEVICE fields. Note the Start Date defaults to Today minus 7 days, and the Stop Date defaults to today.

33 Press <PF1> E to run the report. A sample report is shown below. 

Example: Unknown Action Status Report
BCMA UNKNOWN ACTION STATUS REPORT                                                                             Page: 1 of 1

Date/Time: JUL 12, 2006@13:18:38

Report Date Range:  Start Date: JUL 01, 2005   Stop Date: JUL 12, 2006

Division: ALBANY                                                                          Total *UNKNOWN* entries found: 1

     This is a report of entries, created within the given date range,
     in the BCMA Medication Log File with UNKNOWN Action Status data.

     These entries can be corrected using the BCMA GUI "Edit Med Log".

==================================================================================
1.)

     Action Status...: *UNKNOWN*

     Patient.........: (000009678) BCMAPATIENT, ONE

     Ward/Bed........: GENERAL MEDICINE

     Order Number....: 2U

     Orderable Item..: VITAMIN E CAP, ORAL

     Schedule........: Q4H

     Scheduled Adm Tm: JULY 12, 2006@17:00

     Created Dt/Tm...: JULY 12, 2006@13:06:26

     Created By......: (10000000035) BCMANURSE,ONE

----------------------------------------------------------------------------------



Running the Unknown Action Status Report
	[image: image67.wmf][image: image68.wmf]BCMA Parameter.lnk

Creating a Listing of Unknown Actions (cont.)

	You can use the Unknown Action Status Report [PSBO XA] option from the Bar Code Medication Administration Manager menu to print a listing of administrations that have an unknown action status. When a user is in the process of documenting an administration in Manual Medication Entry [PSB MED LOG NEW ENTRY], the administration status initially defaults to blank (null). If the order is not completed with a valid administration status, the Admin Status will be listed as unknown, and appear on the Unknown Action Status Report. 

The unknown (null) status can occur during Manual Medication Entry when the user’s network connection is broken, their terminal emulator software malfunctions, or if the user improperly exits out of the application.

Use the BCMA GUI Edit Med Log to correct the administration status of any entries found on this report.

Note: This report is only accessible to users with the PSB MANAGER security key. 
To run the Unknown Action Status Report
34 At the Bar Code Medication Administration Manager menu, type U, and then press <Enter> to access the Unknown Action Status Report [PSBO XA] option. The associated screen then displays.

Example: Unknown Action Status Report
Report Criteria Screen
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Customizing the BCMA GUI Tools Menu 
	Defining the Tools Menu in VistA
	BCMA provides a feature to define custom tools menus in VistA for use in the BCMA GUI. This allows users a convenient way to launch frequently used applications directly from within the BCMA GUI. Applications can be added to menus that correspond to the following levels: User, Location, Service, Division, System, and Package. The following is an example of a customized menu displayed in the BCMA GUI.
Example: Customized Tools Menu
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To define a custom tools menu for use in BCMA GUI
35 In VistA, select the BCMA GUI  Tool Menu Items [PSB TOOL MENU ITEMS]option. The following menu appears:
1   User      USR  [choose from NEW PERSON]
2   Location  LOC  [choose from HOSPITAL LOCATION]
2.5 Service   SRV  [choose from SERVICE/SECTION]
3   Division  DIV  [choose from INSTITUTION]
4   System    SYS  [CTST.FO-BIRM.MED.VA.GOV]
9   Package   PKG  [BAR CODE MED ADMIN]
36 Enter a menu level (above) to customize, then press <Enter>. For example, 1 for User, 2 for Location, etc. When prompted, type the specific New Person, Hospital Location, etc., to which the custom menu will be assigned then press <Enter>.
Note: The lowest menu level defined here determines which menu level is loaded when the BCMA GUI is executed. For example, if the User and Division menu levels are both defined, the User menu displays in BCMA. When all menu items in the User level menu are deleted (using @ symbol), then the Division menu will display in BCMA.



Customizing the BCMA GUI Tools Menu
	Defining the Tools Menu in VistA (cont.)
	To define a custom tools menu for use in BCMA GUI (cont.)

37 At the “Select Sequence” prompt, enter a sequence number for the menu item you want to add or edit, then press <Enter>. This number controls the order in the menu items are displayed in BCMA. 1 is the first item, 2 is the second item, etc. If adding a new menu item, answer Yes at the “Are you adding # as a new Sequence?” prompt. If editing an existing sequence, press <Enter> to confirm the sequence number shown.

Note: At the Select Sequence prompt, type ? <Enter> to see a list of existing menu definitions for the selected level, or type ?? <Enter> to get extended help for this option.

38 At the “Name=Command:” prompt, enter the name of the menu option as you want it to display in the BCMA Tools menu, then an equal sign, then the command string used to run the application or web page, then press <Enter>. For example, Calculator=C:\WINDOWS\SYSTEM32\CALC.EXE.


Note: Be sure to specify the complete path or web address, including any parameters that  must be passed to the executable. 

Note: In each menu item, you can place an ampersand character “&” before the letter you want to designate as a keyboard shortcut. For example, &Calculator would assign the letter C to be the keyboard shortcut for this menu item. The ampersand can be assigned to any letter in the menu option name.
39 Repeat steps 3 and 4 above for each menu option you want to add or edit at the selected menu level.




Example: Command Strings for Customized Tools Menu
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Customizing the BCMA GUI Tools Menu
	Defining the Tools Menu in VistA (cont.)
	To define a custom tools menu for use in BCMA GUI (cont.)

40 When you have defined all desired menu options for a selected level, run the BCMA GUI and select the Tools menu and confirm the following: 

· All menu options are displayed in the order you want.

· All menu options can be executed by clicking the mouse or using keyboard navigation, and any defined shortcut keys work as expected.

· All menu options launch the correct application or web page.


Glossary

	Learning BCMA Lingo
	The alphabetical listing, in this section, is designed to familiarize you with the many acronyms and terms used throughout this manual.


Example: Alphabetical Listing of BCMA Acronyms and Terms

	Acronym/Term
	Definition

	Active
	When a medication has been finished and verified, it becomes “active,” and displays on the VDL under the related Medication Tab. A nurse can then administer the medication to the patient. Under the IV Medication Tab, this information is listed in the Status column.

	BCMA
	Bar Code Medication Administration. A VistA software application used in VAMCs for validating patient information and medications against active medication orders before being administered to a patient.

	BCMA Clinical Reminders
	A marquee located in the lower, right-hand corner of the VDL that identifies PRN medication orders needing effectiveness documentation. The setting is based on the “PRN Documentation” site parameter, and applies to current admissions or the site parameter timeframe (whichever is greater). A mouse-over list displays when the pointer is placed over the PRN Effectiveness Activity, or a full list is available by double clicking on the Activity.

	CHUI
	Character-based User Interface.

	Client
	An architecture in which one computer can get information from another. The Client is the computer that asks for access to data, software, or services.

	Clinician
	Nursing personnel who administer active medication orders to patients on a ward. In a VAMC, a number of teams may be assigned to take care of one ward, with specific rooms and beds assigned to each team.

	Continuous Order
	A medication given continuously to a patient for the life of the order, as defined by the order Start and Stop Date/Time.

	CPRS
	Computerized Patient Record System. A VistA software application that allows users to enter patient orders into different software packages from a single application. All pending orders that appear in the Unit Dose and IV packages are initially entered through the CPRS package. Clinicians, Managers, Quality Assurance Staff, and Researchers use this integrated record system.

	ESig
	Electronic Signature Code.

	FileMan
	The VistA database management system.

	Finish
	The process in which the Pharmacist adds the information necessary to make the order active. For example: dispense drug, and start/stop date.


Glossary

	Learning BCMA Lingo (cont.)
	The alphabetical listing, in this section, is designed to familiarize you with the many acronyms and terms used throughout this manual.


Example: Alphabetical Listing of BCMA Acronyms and Terms

	Acronym/Term
	Definition

	Given
	When a medication is administered to a patient, it is considered to be “Given” and marked as such (with a “G”) in the Status column of the VDL.

	GUI
	Graphical User Interface. 

	IEN
	Internal Entry Number. The internal entry drug number entered by Pharmacy personnel into the DRUG file (#50) to identify Unit Dose and IV medications.

	Internal Entry Number
	Also called “IEN,” the internal entry drug number entered by Pharmacy personnel into the DRUG file (#50) to identify Unit Dose and IV medications.

	IV
	A medication given intravenously (within a vein) to a patient from an
IV Bag. IV types include Admixture, Chemotherapy, Hyperal, Piggyback, and Syringe.

	MAH
	Medication Administration History. A patient report that lists a clinician’s name and initials, and the exact time that an action was taken on an order (in a conventional MAR format). Each order is listed alphabetically by the orderable item. The Date column lists three asterisks (***) to indicate that a medication is not due. The report also lists information about when an order is placed “On Hold” and taken “Off Hold” by a provider, and the order Start and Stop Date/Time for the medication.

	MAR
	Medication Administration Record. The traditional, handwritten record used for noting when a patient received a medication. BCMA replaces this record with an MAH.

	Medication Administration History Report
	Medication Administration History. A patient report that lists a clinician’s name and initials, and the exact time that an action was taken on an order (in a conventional MAR format). Each order is listed alphabetically by the orderable item. The Date column lists three asterisks (***) to indicate that a medication is not due. The report also lists information about when an order is placed “On Hold” and taken “Off Hold” by a provider, and the order Start and Stop Date/Time for the medication.


Glossary

	Learning BCMA Lingo (cont.)
	The alphabetical listing, in this section, is designed to familiarize you with the many acronyms and terms used throughout this manual.


Example: Alphabetical Listing of BCMA Acronyms and Terms

	Acronym/Term
	Definition

	Medication Route
	Also called “Route” or “Med Route,” the method by which a patient receives medication (i.e., PO, IV, IM, ID, SQ, and SC). Each VAMC determines routes and associated abbreviations, which cannot exceed five characters in length. Otherwise they will not fit on bar code labels and the MAH.

	Medication Tab
	Used to separate and view a type of active medication order (i.e., Unit Dose IV Push, IV Piggyback, and large-volume IVs) that needs to be adminstered to a patient. The Tab under which an order displays depends on how it was entered. The “alert light” on a Tab turns GREEN only when a medication order exists for the Schedule Type selected within the respective start/stop date and time selected on the BCMA VDL. If grayed out, then none exist.

	Missing Dose
	A medication considered “Missing.” BCMA automatically marks this order type (with an “M”) in the Status column of the VDL after you submit a Missing Dose Request to the Pharmacy. If an IV bag displayed in the IV Bag Chronology display area of the VDL is not available for administration, you may mark the IV bag as a “Missing Dose” using the Missing Dose button or by right clicking the IV bag and selecting the Missing Dose command in the Right Click drop-down menu.

	National Drug Code 
	Also called “NDC,” the number assigned by a manufacturer to each item/medication administered to a patient.

	NDC
	National Drug Code. The number assigned by a manufacturer to each item/medication administered to a patient.

	On-Call Order
	A specific order or action dependent upon another order or action taking place before it is carried out. For example, “Cefazolin 1gm IVPB On Call to Operating Room.” Since it may be unknown when the patient will be taken to the operating room, the administration of the On-Call Cefazolin is dependent upon that event.


Glossary

	Learning BCMA Lingo (cont.)
	The alphabetical listing, in this section, is designed to familiarize you with the many acronyms and terms used throughout this manual.


Example: Alphabetical Listing of BCMA Acronyms and Terms

	Acronym/Term
	Definition

	One-Time Order
	A medication order given one time to a patient such as a STAT or NOW a order. This order type displays for a fixed length of time on the VDL, as defined by the order Start and Stop Date/Time or until it is Given.

	Orderable Item
	A drug whose name does NOT have the strength associated with it (e.g., Acetaminophen 325 mg). The name with a strength is called the “Dispensed Drug Name.”

	Patient Transfer Notification
	A message that displays when a patient’s record is opened or the Unit Dose or IVP/IVPB Medication Tab is viewed for the first time. It indicates that the patient has had a movement type (usually a transfer) within the site-definable parameter, and the last action for the medication occurred before the movement, but still within the defined timeframe.

	Pending Order
	An order entered by a provider through CPRS without Pharmacy personnel verifying the order.

	PRN Effectiveness List Report
	A report that lists PRN medications administered to a patient that needs Effectiveness comments.

	PRN Order
	The Latin abbreviation for Pro Re Nata. A medication dosage given to a patient on an “as needed” basis.

	Provider
	Another name for the “Physician” involved in the prescription of a medication (Unit Dose or IV) to a patient.

	PSB CPRS MED BUTTON
	The name of the security “key” that must be assigned to nurses who document verbal- and phone-type STAT and medication orders using the CPRS Med Order Button on the BCMA VDL.

	PSB INSTRUCTOR
	The name of the security “key” that must be assigned to nursing instructors, supervising nursing students, so they can access user options within BCMA V. 3.0.

	PSB MANAGER
	The name of the security “key” that must be assigned to managers so they can access the PSB Manager options within BCMA V. 3.0.

	PSB STUDENT
	The name of the security “key” that must be assigned to nursing students, supervised by nursing instructors, so they can access user options with BCMA V. 3.0. This key requires that a nursing instructor sign on to BCMA V. 3.0.


Glossary

	Learning BCMA Lingo (cont.)
	The alphabetical listing, in this section, is designed to familiarize you with the many acronyms and terms used throughout this manual.


Example: Alphabetical Listing of BCMA Acronyms and Terms

	Acronym/Term
	Definition

	Refused
	The status for an IV bag or Unit Dose to indicate that the patient refused to take the dose.

	Schedule Type
	Identifies the type of schedule (i.e., Continuous, PRN, On-Call, and One-Time) for the medication being administered to a patient.

	Security Keys
	Used to access specific options within BCMA V. 3.0 that are otherwise “locked” without the security key. Only users designated as “Holders” may access these options.

	Solution
	A homogeneous mixture of two or more substances. For IVs, these would be liquids.

	Start Date/Time
	The date and time that a medication is scheduled for administration to a patient.

	STAT Order
	A medication order given immediately to a patient, entered as a One-Time order by providers and pharmacists. This order type displays for a fixed length of time on the VDL, as defined by the order Start and Stop Date/Time.

	Stop Date/Time
	The date and time that a medication order will expire, and should no longer be administered to a patient.

	Strength
	The degree of concentration, distillation, or saturation of a medication.

	Unit Dose
	A medication given to a patient, such as tablets or capsules.

	VDL
	Virtual Due List. An on-line “list” used by clinicians when administering active medication orders (i.e., Unit Dose, IV Push, IV Piggyback, and large-volume IVs) to a patient. This is the Main Screen in BCMA V. 3.0.

	Verify
	When a nurse or a Pharmacist confirms that a medication order is accurate and complete, according to the information supplied by the Provider.

	Virtual Due List
	Also called “VDL,” an on-line list used by clinicians when administering active medication orders to a patient. This is the Main Screen in
BCMA V. 3.0.

	VistA
	Veterans Health Information Systems and Technology Architecture.
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tip:


BCMA is designed to augment, not replace, the clinical judgment of the medication administrator, or clinician.
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tip:


Only individuals holding the PSB MANAGER security key can access the Bar Code Medication Administration Manager menu.
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tip:


Use this guide for working with the CHUI version of BCMA, V. 3.0.
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tip:


Bookmark these sites for future reference.
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tip:


Bookmark these sites for future reference.
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tip:


In a CHUI environment, when you press enter, instead of typing a response, the system accepts the default value shown to the left of the double slash (//) at a prompt or a field.
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tip:


In a CHUI environment, when you press the ENTER key, instead of typing a response, the system accepts the default value shown to the left of the double slash (//) at a prompt or field.
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tip:


Accessing the GUI BCMA Site Parameters application Main Screen is simple. Just double-click on the BCMA icon on your desktop, and then enter information when prompted by the system. See the example provided below.
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tip:


You can skip�steps 3 and 4�by typing your Access Code, and then your Verify Code — separated by a semi-colon — in the Access Code field. Click ok after typing�the codes.
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tip:


You can skip steps 2 and 3 by typing your Access Code, then your Verify Code, separated by a semi-colon in the Access Code field. Press ENTER after typing the codes.
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tip:


Modifying the “BCMA On-line” parameter affects all users signing on to your division. Multi-division sites must disable access to each site.
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tip:


The Continuous, One-Time, and�On-Call Schedule Type parameter check boxes are “checked” and “disabled”to ensure that these Schedule Types automatically display on the CHUI Due List and on the BCMA VDL.
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tip:


Users can double click on the PRN Effectiveness Activity in the BCMA Clinical Reminders marquee to document ALL�PRN medication orders needing effectiveness documentation.
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tip:


The maximum characters allowed for the free-text Default Answer Lists is 30.
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tip:


If you select the “Requires Pain Score” check box when adding or renaming a “Reason Medication Given PRN” item, users will be required to select a pain score in the Medication Log and PRN Effectiveness dialog boxes when administering a medication.
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tip:


The maximum characters allowed for a new,�or a renamed, Answer Lists item�is 30.
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This is the “Attribute” shown in the example above.





Medication Tabs with “alert light” 





Order on “Hold”





Status Bar





Scanner Indicator
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tip:


Check out the “Reports” and “Administering …” chapters to learn how the features listed here work�in BCMA.
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tip:


During your med pass, refresh BCMA periodically to check for new, active medication orders.





Medication Order Display Area





Column Headers





Tool Bar





Menu Bar
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tip:


Check out the “Reports” and “Administering …” chapters to learn how the features listed here work�in BCMA.





Minimize Button





Maximize Button





�











tip:


After a Med Pass, press f5 to refresh the VDL with current medication order information, and to update the information in the Status and Last Action columns.





Allergies/ADRs Bar





Patient Demographics Button
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tip:


In the Example provided, the reset iv type button is located below the Type drop-down �list box.
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tip:


If you later determine that you need to use the default settings for “ALL” (wards) simply select the ward in the Ward drop-down list box, and then click the reset iv type button. A Warning message will display, informing you that the system will revert to the Division (ALL) settings.
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tip:


In the Example provided, the reset iv type button is located below the Type drop-down �list box.





�











�tip:


You must hold the PSB MANAGER security key to access the BCMA Manager Menu.
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tip:


You can type a ? to display a listing of the Pharmacy Reasons Needed.
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tip:


The Reset User Parameters [PSB USER PARAM RESET] option is particularly useful when a user is unable to access a screen, or is not satisfied with their user-defined parameters.
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tip:


The reason also displays on the BCMA VDL being used by the clinician administering medications for the administration time listed.
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tip:


Adiminstrations with an Unknown action status also display on the BCMA VDL and Cover Sheet in the GUI.





�











tip:


The CHUI version of this report allows the user to select by Division.





tip:


The CHUI version of this report allows the user to select by Division.
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tip:


Adiminstrations with an Unknown action status also display on the BCMA VDL and Cover Sheet in the GUI.








tip:


The CHUI version of this report allows the user to select by Division.
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tip:


Adiminstrations with an Unknown action status also display on the BCMA VDL and Cover Sheet in the GUI.
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Sequence  Value


--------  -----


1         Clinical &Pharmacology="http://www.clinicalpharmacology-ip.com"


2         &UpToDate=http://vha99webapp.v99.med.va.gov/uptodate.asp


3         &VITALS="C:\V99Library\Vitalsldr.exe" S=<server> P=<port>


4         BCMA &Training=http://vaww.vistau.med.va.gov/vistau/barcode/default.htm
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